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CubeMX install

• CubeMX tool

• http://www.st.com/web/catalog/tools/FM147/CL1794/SC961/SS1533/PF259242?s_searchtype=partnumber

• The CubeMX tool need java

• Please check if you have last java on your pc, for sure 32bit and 64bit version

• How to solve problems with installation look into User manual UM1718, into FAQ section

• http://www.st.com/web/catalog/tools/FM147/CL1794/SC961/SS1533/PF259242?s_searchtype=partnumber
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CubeMX install

• The CubeMX can generate the code for some IDE

• Atollic TrueSTUDIO

• IAR

• Keil

• System Workbench

• For the debugging is necessary to have the ST-Link drivers

• STSW-LINK009 driver for Win XP/Vista/7/8/10

http://www.st.com/web/en/catalog/tools/PF260219

• For driver installation you will need the Admin rights on your PC
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CubeMX repository configuration

• Install the CubeMX

• Run CubeMX 
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CubeMX 

repository
Project

The CubeMX is 

used for 

configuration

For project 

generation we also 

need configure 

repository

Then CubeMX is 

able to generate 

project



The ”/” in the end of Repository is necessary

CubeMX repository configuration

• In case you download the package from web we need to find the place where they need to be stored

• MENU>Help>Updater Settings…

• You will see where is the repository folder

• Default is C:/User/Acc_name/STM32Cube/Repository/

• In case that you have in your repository path diacritics, the CubeMX may not work properly, please change you repository 

path (ex: C:/Repository)

• You need to download STM32 packages into this folder

• Or CubeMX automatically download them into this folder
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CubeMX 

repository

Specifying path to 

repository



CubeMX repository configuration

• The comparison of the CubeMX repository settings and structure in this folder

• In case you want to download this files

automatically use in CubeMX

• MENU>Help>Install New Libraries

• Select libraries which you want

• Force download with button Install Now
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Example how the 

repository structure 

looks likeCubeMX can download for you the 

repository packages automatically



STM32CubeMX presentation



STM32Cube: STM32CubeMX

Step by step:

• MCU selector

• Pinout configuration

• Clock tree initialization

• Peripherals and middleware parameters

• Code generation

• Power consumption calculator
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Pinout Wizard

Clock Tree wizard

Peripherals & Middleware

Wizard

Power Consumption

Wizard

STM32CubeMX



STM32CubeMX: MCU Selector

Easy Optional filtering:

• Series

• Line

• Package

• Peripherals
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STM32CubeMX: Pinout configuration 11

• Pinout from:

• Peripheral tree

• Manually

• Automatic signal remapping

• Management of dependencies between

peripherals and/or middleware 

(FatFS, LWIP, …)



STM32CubeMX: Pinout configuration 12

• Pinout from:

• Peripheral tree

• Manually

• Automatic signal remapping

• Management of dependencies between

peripherals and/or middleware 

(FatFS, LWIP, …)

• Motor Control Library is not part of 

STM32CubeMX Middleware, but is added 

(to .ioc file )externally by ST Motor 

Control Workbench



STM32CubeMX: Pinout configuration

• Different possible states for a peripheral modes

• Green:

Periphery is assigned to pinout
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Green:

Periphery will be 

functional



STM32CubeMX: Pinout configuration

• Different possible states for a peripheral modes

• Yellow: 

Only some functionalities of 

periphery can be used
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Yellow:

On ADC only some 

channels can be used



STM32CubeMX: Pinout configuration

• Different possible states for a peripheral modes

• Red:

Signals required for this mode 

can’t be mapped on the pinout

(see tooltip to see conflicts)
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Red:

Periphery cannot be 

used in this pinout

setup



STM32CubeMX: Pinout configuration

• Keep User Placement renamed to Keep Current Signal Placement and is unchecked by 

default
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1. I2C1 selected

2. I2C1 pin 

assignment

3. SWD selected

4. Pin conflict between I2C1 

and SWD. I2C1_SDA moved 

to alternative position



STM32CubeMX: Pinout configuration

• Keep User Placement renamed to Keep Current Signal Placement and is unchecked by 

default
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Keep Current Signal 

Placement checked now 

CubeMX cannot move 

selected signals to different 

alternate pin

I2C1 cannot be moved and 

SWD/JTAG cannot be used 



STM32CubeMX: Pinout configuration

• Signals can be set/moved directly from the pinout view

• To see alternate pins for a signal Ctrl+Click on the signal, you can then drag and drop the signal to the new pin 

(keep pressing the Ctrl key)
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1. Ctrl+Click on pin

2. Show alternative 

positions

3. Move pin to new position



STM32CubeMX: Clock tree

• Immediate display of all clock values

• Management of all clock constraints

• Highlight of errors
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STM32CubeMX: Peripheral and middleware configuration

• Global view of used peripherals and middleware

• Highlight of configuration errors

+ Not configured

ⱱ OK

x Error

• Read only tree view on the left 

with access to IPs / Middleware 

having no impact on the pinout
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STM32CubeMX: Peripheral and middleware configuration

• Parameters with management of dependencies

and constraints

• Interrupts

• GPIO

• DMA
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STM32CubeMX: Peripheral and middleware configuration

• Manage Interruptions

• priorities can only be set in the NVIC global view

• Manage GPIO parameters

• Manage DMA

• Configure all the parameters of the DMA request 

• Runtime parameters (start address, …) are not managed
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NVIC Panel

• Manage all interruptions

• Manage priorities and sort by priorities

• Search for a specific interrupt in the list
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DMA Panel

• Manage All DMA requests including Memory to Memory

• Set Direction and priority

• Set specific parameters
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GPIO Panel

• Most of the GPIO parameters are set

by default to the correct value

• You may want to change the maximum 

output speed

• You can select multiple pin at a time

to set the same parameter
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STM32CubeMX: Power consumption calculator

• Power step definitions

• Battery selection

• Creation of consumption graph

• Display of 

• Average consumption

• Average DMIPS

• Battery lifetime
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STM32CubeMX: Code generation

• Generation of all the C initialization code

• Automatic integration with partners toolchains

• User code can be added in dedicated sections 

and will be kept upon regeneration

• Required library code is automatically copied 

or referenced in the project (updater)
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STM32CubeMX: Updater

• Help->Updater settings

• Choose location of STM32CubeFx firmware libraries repository

• Choose manual or automatic check

• Set Connection proxy

• Inside ST use appgw.sgp.st.com port 8080 with your windows login name and password

• Help->Install new libraries : Manage the content of the library repository

• Click on the check button to see what is available

• Select the library you want to install and click install now

• The libraries will be automatically downloaded and unzipped
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Can be happen, that STM32CubeMX window in ST MC Workbench get you errors during 

generation(but generated code is proper). You change  in Updater Settings  in Check and 

Update Settings to Manual Check and Data Auto-Refresh to No Auto-Refresh at application 

start



STM32CubeMX: Project settings

• Project -> Settings

• Set project name and location

• A full folder will be created named with 

project name.

• Inside this folder you’ll find the saved 

configuration and all the generated code

• Select toolchain

(Keil, IAR, Atollic, SW4STM32)

• You can choose to use the latest

version of the firmware library or 

a specific one(older)
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STM32CubeMX: Code Generator settings

• Code generator options

• Either copy the full library or only the necessary files

or just reference the files from the common repository

• Generate all peripherals initialization in

stm32fYxx_hal_msp.c file or one file per peripheral

• Keep user code or overwrite it (code between 

User code comment sections)

• Delete or keep files that are not useful anymore

• Set free pins as analog, this settings helps keep

low consumption (if SWD/JTAG is not selected 

in pinout, this option will disable it)

• Enable full assert in project, this help discover

incorrect HAL function parameter used in user code
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Keep User Code when re-generating

• Generated code contains USER CODE areas

• This areas are reserved in new code generation, if this option is selected
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/* USER CODE BEGIN PFP */

/* USER CODE END PFP */
/* USER CODE BEGIN 0 */

/* USER CODE END 0 */
int main(void)
{
/* USER CODE BEGIN 1 */

/* USER CODE END 1 */
/* MCU Configuration----------------------------------------------------------*/
/* Reset of all peripherals, Initializes the Flash interface and the Systick. */
HAL_Init();
/* Configure the system clock */
SystemClock_Config();
/* Initialize all configured peripherals */
/* USER CODE BEGIN 2 */

/* USER CODE END 2 */
/* USER CODE BEGIN 3 */
/* Infinite loop */
while (1)
{

}
/* USER CODE END 3 */

}

Here can user put his code, code will be 

preserved during project generation 



Keep User Code when re-generating

• Generated code contains USER CODE areas

• This areas are reserved in new code generation, if this option is selected

• Areas present in files generated by CubeMX

• Main.c

• Stm32f4xx_it.c

• Stm32f4xx_hal_msp.c

• Areas cover important areas used for:

• Includes

• Variables

• Function prototypes

• Functions
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/* USER CODE BEGIN PFP */

/* USER CODE END PFP */
/* USER CODE BEGIN 0 */

/* USER CODE END 0 */



STM32Cube HAL package



STM32CubeTM V1 Introduction

• STM32CubeTM Version 1:

• A configuration tool, STM32CubeMX generating initialization code from user choices

• A full embedded software offer, delivered per series (like STM32CubeF3) with:

• An STM32 Abstraction Layer embedded software: STM32Cube HAL

• A consistent set of Middlewares: Motor Control,RTOS, USB, TCP/IP, Graphics, …

• Available at st.com as free solution
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STM32CubeMX

http://www.st.com/stm32cube
http://www.st.com/stm32f4


Supporting files like fonts, 

or pictures for graphic 

examples, …

STM32Cube FW Package Organization 35

Cube XX 
HAL package

Documents Drivers Middleware Projects Utilities

Can be found in 

CubeMX repository

Getting started with 

CubeF3 document

http://www.st.com/stm32f4


Drivers

CMSIS STM32Fxxx_HAL_Driver BSP

STM32Cube FW Package Drivers 36

Register definitions for 

Core, startup files, 

ARM cortex libraries

Cube F4 HAL 
package

Documents Drivers Middleware Projects Utilities

HAL Drivers for each 

periphery in STM32

Board Support Package 

contains function which 

use HAL drivers to 

communicate with other 

components present n 

EVAL/Discovery boards

http://www.st.com/stm32f4


STM32Cube FW Package Middlewares 37

Middlewares

ST

STemWin STM32_Audio

STM32_USB_Device_Library STM32_USB_Host_Library

Third Party

FatFS FreeRTOS

LibJPEG LwIP

PolarSSL

Advanced set of 

libraries

Third Party libraries
Developed/Owned by ST

Cube F4 HAL 
package

Documents Drivers Middleware Projects Utilities

http://www.st.com/stm32f4


STM32Cube FW Package Projects 38

Projects

STM32F-Discovery

Templates Examples Applications Demonstations

….

Complete projects for 

STM32 boards STM32Nucleo, 

Discovery kits, Eval

Boards

Empty project only with 

startup file prepared for 

modification

Demonstration 

project combine 

multiple 

Middlewares

together

Cube F4 HAL 
package

Documents Drivers Middleware Projects Utilities

Advanced examples 

which use Middlewares

(USB virtual com port)

Simple examples for 

STM32 Peripheries 

(GPIO, USART, …)

http://www.st.com/stm32f4


STM32Cube FW Package Organization 39



Examples repository 40

Examples that are based 

ONLY on HAL drivers

(as of today)

NEW Examples that are 

based on HAL and LL drivers 

(Mixed)

NEW Examples that are 

based ONLY on LL drivers

Each IP which offer Initialization 

functions, provide ONE example to 

demonstrate his usage 

(USE_FULL_LL_DRIVER activated)



LL example
Mixed example 

(HAL + LL)

Examples files 41

Files Description

main.c This file should include the example program It should include only the

main.h file

main.h Header of the main program file: it should include the associated low

layer drivers header files and example defines and data structures

when needed.

system_stm32yyxx.c CMSIS Cortex-Mx Device Peripheral Access Layer System Source

File.

stm32yyxx_it.c This file contains main Interrupt Service Routines.

stm32_assert.h This file contains the assert_param macro implementation, at least

needed by stm32yyxx_utils.c which provides utility services.

stm32yyxx_it.h This file contains the headers of the interrupt handlers.

Readme.txt This file contains Example usage explanations for end user.



STM32Cube vs. StdLib

• Existing Standard Peripheral Libraries (StdLib) will be supported, but 

not recommended for new designs

• StdLib will be updated to support new F0/F3/F4 derivatives

• No StdLib for new Series, such as L0/L4/F7

• Migrating an application from StdLib to STM32Cube: 

• The 2 solutions are completely different (different architecture, APIs set…) and thus 

there is no direct migration path, i.e. no “find and replace” possibility. 

• Customers needs to rewrite their applications developed on StdLib to work with 

STM32Cube. 

• Combined with the fully portable HAL, user will do the migration to STM32Cube 

only once  then  can  easily  migrate  to  any  other  MCU  with  more  performance,  

memory, and  peripherals  without  rewriting  the  application.  As  a  result,  

developers  can leverage  the  same  application  and  toolchain  across  an  entire  

product  line  and  a variety of MCUs. 
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STM32Cube Hardware Abstraction Layer 

(HAL)



HAL general concepts



HAL general concepts

The HAL in STM32Cube FW package
45

Hardware Abstraction Layer  API Boards Support Packages

Drivers

HAL level Examples

Board Demonstrations

Evaluation boards Discovery  boards Nucleo boards

Networking

LwIP TCP/IP  

& Polar SSL

File system

FATFS

Graphics

STemWin

USB 

Host & Device 

Middleware level  Applications

Middleware

RTOS

FreeRTOS

F4 Family

STM32F401

CMSIS

Utilities

STM32F405/7 STM32F429 STM32F439

HAL



HAL general concepts 

HAL based project organization
46

stm32f4xx_hal.h

stm32f4xx_it.c

user_code.c

Source files Include files

stm32f4xx_hal_def.h

startup_stm32f4xx.s

system_stm32f4xx.c stm32f4xx.h

CMSIS

stm32f4xx_hal_conf.h

stm32f4xx_hal_ppp.c

stm32f4xx_hal_ppp_ex.c

stm32f4xx_hal.c

HAL Drivers

User Code

user_code.h

stm32f4xx_it.h

stm32f4xx_hal_ppp.h

stm32f4xx_hal_ppp_ex.h



HAL general concepts

HAL configuration file

• The HAL config file stm32f4xx_hal_conf.h allows to select the modules to include:

• It defines also some system and HAL parameters including

• HSE clock/HSI clock values

• Instruction/data cache and prefetch queue setting

• VDD voltage value
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/* ########################## Module Selection ############################## */
/**
* @brief This is the list of modules to be used in the HAL driver
*/

#define HAL_MODULE_ENABLED
//#define HAL_ADC_MODULE_ENABLED
//#define HAL_CAN_MODULE_ENABLED
//#define HAL_CRC_MODULE_ENABLED
//#define HAL_CRYP_MODULE_ENABLED
//#define HAL_DAC_MODULE_ENABLED
//#define HAL_DCMI_MODULE_ENABLED
//#define HAL_DMA2D_MODULE_ENABLED
//#define HAL_ETH_MODULE_ENABLED
//#define HAL_NAND_MODULE_ENABLED
//#define HAL_NOR_MODULE_ENABLED

Commented modules will be not included into project 

this may cause errors



HAL general concepts

Callbacks
• Cube HAL library use the callbacks

• To inform application about interrupts

• About periphery initialization/deinitialization

• The callback functions are defined as __weak

• You can find them in stm32f4xx_hal_xxx.c
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/**
* @brief Tx Transfer completed callbacks
* @param hspi: pointer to a SPI_HandleTypeDef structure that contains
*                the configuration information for SPI module.
* @retval None
*/

__weak void HAL_SPI_TxCpltCallback(SPI_HandleTypeDef *hspi)
{

/* NOTE : This function Should not be modified, when the callback is needed,
the HAL_SPI_TxCpltCallback could be implemented in the user file

*/
}

SPI callback are in stm32fxxx_hal_spi.c or in 

stm32fxxx_hal_spi_ex.c



HAL general concepts

Init functions
• HAL_XXX_Init() functions

• Inside init function are written data from input parameters/structure into registers

• Before the register write is processed HAL_XXX_MspInit callback is called
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HAL_xxx_Init() start

HAL_xxx_MspInit()

HAL_Init() end

MSP callback defined as __weak

Initialize periphery

CubeMX generate the MSP callback 

automatically in 

stm32f4xx_hal_msp.c 



HAL general concepts

HAL API returns parameters
• HAL API can return a value of enumerated type HAL_StatusTypeDef:

• HAK_OK  :   API executed with success

• HAL_ERROR :  API call parameters error or operation execution error

• HAL_BUSY : API was not executed because peripheral is  busy with other operation

• HAL_TIMEOUT : API timeout error
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HAL_XXX Function

HAL_OK HAL_BUSY HAL_ERROR HAL_TIMEOUT



Low Layer drives



Context
• February 2014: 1st Release of STM32CubeV1 solution, based on F4 Series

• After this release, we received some concerns about the HAL, mainly:

• Big code called at peripheral initialization

• Need to go-through full peripheral initialization even if slight modification is needed at run-time, making it inefficient

• User have limited access to the peripheral resources and control

• Missing level equivalent to SPL

➔ New Low Layer (LL) APIs will be the answer 

• STM32Cube HAL & LL are complementary and covers a wide range of applications requirements:

• HAL offers high level and functionalities oriented APIs, with high portability level and hide product/IPs complexity 

to end user

• LL offers low level APIs at registers level, w/ better optimization but less portability and require deep knowledge of 

the product/IPs specification
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STM32Cube FW package block view

Hardware Abstraction Layer  API Boards Support Packages

Drivers

HAL level examples

Board Demonstrations

Evaluation boards Discovery  boards Nucleo boards

Networking

LwIP TCP/IP  & 

Polar SSL

File system

FATFS

Graphics

STemWin

USB 

Host & Device 

Middleware level examples

Middleware

RTOS

FreeRTOS

STM32 Series

STM32L4

CMSIS

Utilities

STM32F0 STM32F1 STM32F2 STM32F3 STM32F4

STM32L0 STM32L1 STM32F7

Low Layer Drivers

Low Layer Examples HAL + LL Examples
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Low Layer Drivers scope 55

STM32 snippets

Init 

functions

Unitary functions

LL Drivers

Standard peripheral

library

• Common services 

(portability)

• High level state machine 

based processes

• Init services

• Hardware basic services

• Atomic register access

• Compliancy with the 

HAL drivers

• Low footprint

HAL Drivers



LL Files 56

LL unitary functions 

LL utilities services

LL Init functions

LL drivers  are located in the Src/Inc HAL Driver folders



LL Typical Usage

• The low layer services have to be called following the programming model of the reference 

manual document by calling the elementary low layer drivers services

• Ex : Use GPIO To toggle continuously a LED
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Thank you!


